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Chapter 16  Developing Interpretation Criteria
Chapter 15 introduced you to running interpretation reports and selecting existing
interpretive criteria to run against your data.  This chapter demonstrates how to
create new criteria.  It introduces you to the NASIS Interpretation Generator and two
editors used for building interpretationsthe Evaluation editor and the Rule editor.
With these tools, you can create and generate new interpretations based on current
data and on calculations automatically performed by NASIS, which gives you the
capability of applying new interpretive criteria to your soil data.

It is essential that you read Chapter 14 before attempting the lesson in Chapter 16.
Prior to developing interpretive criteria, you must understand the concepts of
articulating interpretive statements, fuzzy logic, and defuzzification into rating
classes.  See Chapter 14 for a discussion of those concepts.

The NASIS interpretation module is designed for interdisciplinary experts who
thoroughly understand the process of developing interpretive criteria.  In addition,
they must understand the relationships of soil properties to the system or application
being evaluated.  Expert opinion is required throughout the process of creating
interpretive criteria with NASIS.

Use of this module also requires that you have undergone basic NASIS training on
the subjects of navigation, database structure, and object ownership.

Overview of Interpretation Criteria
In NASIS, interpretive results are generated by applying interpretive criteria to soil
data.  Interpretive criteria are divided into four parts:  interpretations, base rules,
evaluations, and properties.

NASIS interpretations
An interpretation or primary rule is a root rule in NASIS. It uses evaluations and
base rules or sub-rules to derive values. It is a logical statement about land use,
limiting features, and the relationship among limiting features.  Interpretations are
stored in the Rule table as shown in Figure 16-1 on the next page.  The land use is
identified as the Rule Name, and the interpretation’s limiting features and the
relationship among them (relative weights and interactions) are depicted graphically
in Figure 16-2 with a special Rule Editor.

 

 

 

 

 

The first nine pages of this chapter provide a conceptual overview of interpretations.  The
overview requires no interaction with the tutorial database.
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Figure 16-1. Rule Table Displaying Engineering Interpretations

Interpretations are
stored in the
NASIS Rule table

Land use is stored
as Rule Name

Limiting features, the
relationships among them,
and their link to the
interpretation are depicted
in a special Rule Editor
accessed from here
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Figure 16-2. Rule Editor Depicting Base Rules

An option lets you add a multiplication
factor that assigns varying importance to
limiting features, or an adjective that has
a mathematical function associated with
it, such as square root or reciprocal

For an interpretation, its limiting
features and the relationships
among them (relative weights
and interactions) are depicted
graphically in a special
Rule Editor

Choice of operators
include AND, OR, SUM,
AVERAGE, and others In the Rule Editor, the

rules, in this case base
rules, are shown as
rectangles
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Base rules
A base rule is a logical statement about one limiting feature.  A base rule says
nothing about the land use; therefore, the same base rule can be used in building
different interpretations.  Base rules are aggregated into an interpretation and are
considered the basis, or building blocks, of an interpretation.  Like interpretations,
base rules are stored in the Rule table, as shown in Figure 16-3 below.  The limiting
feature is stored as the Rule Name.  A naming guideline helps you distinguish base
rules from interpretations.

Base rules have at least one evaluation linked to them.  The linked evaluation(s) are
depicted graphically in the Rule Editor shown in Figure 16-4 on the next page.

 

 
 

 

 

 

 

 

 

Figure 16-3. Rule Table Displaying Base Rules

Base rules are stored in the Rule table with
interpretations.  Refer to Table 16-1 on page
16.23 for a discussion of sequence numbers
associated with each.

The limiting feature is stored
as Rule Name

A Sequence number naming
convention helps you easily
distinguish between base rules
and interpretations.
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Figure 16-4. Rule Editor Showing Link to Evaluation

In order to report out interpretive results, an evaluation must be linked to a base rule.
The base rule gives you the flexibility of reusing evaluations for different
interpretations.

 

In the Rule Editor,
evaluations are
shown as ovals

The link between an
evaluation and a base
rule, and the relationships
among evaluations, are
made and depicted
graphically in the Rule
Editor
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Evaluations
An evaluation is an assessment of a particular soil property for its relative impact as
a limiting feature.  Evaluations are stored in the Evaluation table as shown in Figure
16-5 below.

Using the principles of fuzzy logic (fully explained in Chapter 14), you can graph
the impact in a special Evaluation Editor, as shown in Figure 16-6 on the next page.
The graph helps you evaluate the soil property and its relative truthfulness of being a
limiting feature.  For example, if a soil percs absolutely too slowly, the fuzzy value
would be 1.  If it percs absolutely not too slowly, the fuzzy value would be 0.

Fuzzy logic allows you to evaluate the property when it falls in the range between
absolutely too slowly (1) and absolutely not too slowly (0).  For example, if the soil
percs moderately slowly, you might plot it as 0.5, meaning that the soil has a 0.5
truthfulness of percolating absolutely too slowly.

An evaluation is the relationship between the property and its impact on the
interpretive application.

 

 

 

 

 

 

 

 

 
 

Figure 16-5. Evaluation Table

Evaluations are stored in
the Evaluation table

A special Evaluation Editor
(shown on the next page)
allows you to graph the
relationship between a
property’s value and
its relative truthfulness of
being a limiting feature
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Figure 16-6. Evaluation Editor

Evaluations specify the ranges used to assess the relative truthfulness of a statement
about a soil property.  For example, the evaluation criteria set the limits for
determining whether the statements “soil percs too slowly” and “soil filters too
poorly” are absolutely not true, absolutely true, or somewhere in between.

Fuzzy logic allows us to deal with relative statements about soil properties.  For
example, in our traditional view, the logical statement A AND B means that both A
and B must be absolutely true for the statement to be true.  But with fuzzy logic,
each of A and B represent some degree of truthfulness (membership in a class), from
absolutely not true to absolutely true.  The statement A AND B evaluates the
minimum truthfulness for either of A and B.  Thus, if a soil must be deep and dry in
March to be suitable for early tillage, and the soil is deep but moist, the statement
that the soil is deep is true but the statement that the soil is dry is only partly true.
Therefore, the soil is partly suited to early tillage.

This statement about soil behavior can be understood in terms of relative
truthfulness.  If the soil is very nearly dry, then its degree of truthfulness is very
nearly 1 (perhaps 0.9), and it is very nearly suited (0.9) to early tillage.  The degree
of truthfulness is numerical and can be used in mathematical operations or converted
into classes such as slight, moderate, and severe.  Regardless of how you use it,
fuzzy logic allows you to make more intuitive, more precise, and more useful
interpretations.  This concept helps you deal with relative statements about soil
properties.  If you have not already done so, refer to Chapter 14 for a full discussion
of fuzzy logic.

The Evaluation Editor lets you translate the ranges
of properties into a uniform basis, which in fuzzy
logic is a value between 0 and 1 where 1 means a
statement is absolutely true and 0 means a
statement is absolutely not true
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Properties
A property is the specified soil data retrieved from the soil database.  The term
property can also refer to the SQL-like statement that retrieves the soil data.
Properties are stored in the Property table, as shown in Figures 16-7 and written in
the text editor as shown in Figure 16-8.

 

 

 

 

 
Figure 16-7. Property Table

 
 
 
 

 
 

Figure 16-8. Property Editor

Property name refers to the soil data
being retrieved; in this case,
the minimum permeability values for
horizons in 20-40” (50-100cm)

The actual SQL-like statement that retrieves
the property from the database is created and
stored in this text field editor referred to as the
Property Editor

Properties are retrieved using complex SQL-like statements available from the
NSSC Pangaea site.  Because of their complexity, it is unlikely that you will
edit or create properties, but rather, choose them from a choice list

The SQL-like
statement that
retrieves the
property from the
database is created
in a text field editor
accessed from here
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Summary
Figure 16-9 below illustrates that base rules focus on one limiting feature and must
link to at least one evaluation.  Base rules say nothing about the land use.  Therefore,
you can use them in different interpretations.  Base rules are aggregated into an
interpretation and are considered the basis, or building blocks, of an interpretation.

An evaluation is the relationship between a property’s value and its relative
truthfulness of being a limiting feature.
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Filter Field
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Figure 16-9.  Relationships Among Interpretive Criteria
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Loading and Viewing Existing Criteria
Before you develop some sample interpretive criteria, take some time to view
existing criteria and become familiar with the editors.

Loading existing criteria into the selected set
In this section, you will use the Select Manager to load all of the national properties,
evaluations, base rules, and interpretations into your selected set.

1. On the NASIS File menu, choose Select.
2. In the Select Manager, open the choice list for the Query Name field.
3. Select Tutorial - Property by property name and click Apply.
 

  
4. In the Query Parameters dialog, type * to return all properties owned by the

NSSC Pangaea, then click Apply.
5. A message reports 657 rows added to the selected set.  Click OK.
 Note:  If the number returned differs somewhat, it is probably because more

properties, evaluations and rules are continually being added by NSSC Pangaea.
6. In the Select Manager, choose the query Tutorial - Evaluation by evaluation

name, and click Apply.
7. Type * then click Apply.
8. A message reports 1161 rows added.  Click OK.
9. In the Select Manager, choose the query Tutorial - Rule by rule name, and

click Apply.
10. Type * then click Apply.
11. A message reports 1495 rows added.  Click OK.
12. On the Select Manager, click the Cancel button.

Select
Property by

property
name

Click Apply
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Viewing existing properties
You can retrieve properties from the NSSC Pangaea site using complex SQL-like
statements.  Because of their complexity, it is unlikely that you will edit or create
properties.  Instead, you will likely choose existing ones from a choice list.

When developing criteria, however, you may need to open the Property table and
make sure the property you want to retrieve has an SQL-like statement written for it.

1. Open the Property table by selecting the View, Properties, then click Property.
 

  
2. You will use the Find function to locate a particular property and examine it.  To

begin, click the Property Name column.
3. On the View menu, select Find (near the bottom of the menu).
4. In the Search String field, type PERMEABILITY MAXIMUM IN DEPTH

50-100 cm and click Apply (as shown below).
 
 

 
 

5. With the selected property displayed, click in the Text… column, click the
Zoom button.

6. In the Text Field Editor, read the description of this property, shown below.
 

Property table

Type PERMEABILITY MAXIMUM IN DEPTH 50-100cm
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7. When finished reading the text, click Cancel.
8. In the Property table, click the Property column for the selected property, then

click the Zoom button.  A text field editor, referred to as the Property editor,
displays the SQL-like statement that retrieves the property PERMEABILITY
MAXIMUM IN DEPTH 50 - 100 cm.

 

 

9. When finished viewing this text, click the Cancel button.
10. You can easily see which evaluations use this property by raising the Sash and

clicking the Update Report button (as shown on the next page).
 



Chapter 16:  DEVELOPING INTERPRETATION CRITERIA

(430-739, Version 5.0, Feb. 2001)     16.13

 

 
 Note:  The Where Used report lists the evaluations that use the selected

property.
11. When finished looking at the Where Used report, browse through the Property

table to examine other properties; or proceed to the next section.
 

Viewing existing evaluations
Next you will look at the evaluation that uses PERMEABILITY MINIMUM IN
DEPTH 60 - 150 cm.

1. Open the Evaluation table by selecting the View menu, Evaluations, then click
Evaluation.

 Note:   You may need to scroll to view the evaluation that uses the permeability
property.  (A sample screen appears on the next page.)

 

Move the cursor over the sash box and when
the pointer converts to cross-hairs, click your

mouse button, hold it down, and move the Sash
box upward.  Release the mouse button when

you can see the Where Used report below

Click Update
Report

Where Used
report shows
evaluation(s)
that use the

selected
property

When several
properties

contain similar
names, view the
full name in the

edit window.
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 Note:  Sequence numbers in the Evaluation table can be used to group, maintain,

and develop evaluations.  Unless sequence numbers are used, a save or sort
command will arrange the records in this table in alphabetical order.

2. For the percolation record, highlight the Text... column and click the Zoom
button.  The Text Field Editor displays a description of the evaluation (shown on
the next page).

The evaluation
that uses the
permeability
property, as

detailed in the
Where Used

report
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3. After reading the description, click Cancel to return to the Evaluation table.
4. Open the Evaluation Editor by clicking the Evaluation column, then clicking

the Zoom button.  The Evaluation Editor appears, as shown in the sample screen
on the next page.

 

Indicates the
property checked
by this evaluation

Defines the
fuzzy space

Includes the
Ames

description of the
property

Describes the
calculation used
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5. After viewing the Evaluation editor, click Cancel to close it.
6. To determine what base rules use this evaluation, in the Evaluation table click

the Update Report button.

The type of curve used
to graph the evaluation.
Selection is based on
expert opinion

Data values, such as low and high
curve values ( fields vary depending on
type of curve selected; actual data
entered is based on expert opinion)

Lets you invert the graph
to change the perspective

of the rule (from positive
to negative or vice versa)

Lets you see
the graph in
terms of the
range of
values
accepted by
the database

NASIS site
that owns the

property

The property
being evaluated

Buttons for choosing
local or national

properties

Selects only
properties that
are ready to use
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 Note:  As shown above, the evaluation is linked to one base rule:  Seepage
50 - 100cm (20-40”).

 

Viewing existing base rules
Before writing rules, look at the base rule named Seepage 50 - 100cm
(20-40”).  In doing so, you can acquaint yourself with the Rule table and Rule
Editor.  Recall that you loaded into the selected set all rules from the national
database.

1. Open the Rule table by selecting the View menu, Rules, then clicking Rule.
2. With the cursor in the Rule Name column, select the View menu, then click

Find.
3. Type the name of the base rule and click Apply.  Refer to the sample screen.

One rule is linked to the
highlighted evaluation

Click Update
Report to see

which base
rules link to

the selected
evaluation
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 Note:  The search string (or partial string) can be alpha-numeric characters.

Wildcards are not accepted, but partial words are, such as Perc for Percolation.
4. Highlight the Text… column and click the Zoom button.  Read the rule

description.
 

  
5. When finished looking at the text, click Cancel.
6. In the Rule table, open the Rule Editor by clicking the Rule column then

clicking the Zoom button.
 
 

 

In the Search
String field,

type the rule
name from
the Where

Used Report,
and click

Apply
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 Note:  The Rule Editor lets you illustrate the interpretation or base rule
graphically with symbols called rule components.  Refer to Figure 16-10 on the
next page for a description of each rule component.

The Start
symbol is a

place holder; it
performs no

action.  All
rules have one

and only one
Start symbol

To report out the result of an evaluation, you
must link it to a base rule.  You can then attach
base rules to an interpretation.  The symbols in
this area indicate what is attached to the base
rule

The rule
description

describes the
currently

selected rule
component,
which in this
case, is the

Start Symbol

Provides a
way to add

another rule
component to

the currently
selected rule
component.

Provides a way to
delete the currently

selected component
from the rule

Edit menu offers several options:  Enter or
change rating classes for rules; change
operator, hedge, evaluation or rule for a
selected rule component; change the order of
a set of rule components that have the same
parent component; and change a parameter
value used by a hedge (when the hedge uses
parameters)

Provides a way to
reduce or enlarge
the graphic in the
Rule Editor.
Scaling ranges
from 25% to
300% of original
size
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Figure 16-10.  Rule Components and Symbols

7. When finished looking at the Rule Editor, click Cancel.
8. To find out which other rules or interpretations use this base rule, raise the Sash

and click the Update Report button.
 

 
 

Another rule—Seepage, not Aridic uses the
Permeability base rule
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9. Click Rule in the Seepage, not Aridic row.
10. Click Update Report.

 

Viewing existing interpretations
Because interpretations are stored in the Rule table along with base rules, you can
stay in the Rule table to view them.  In this section, you will learn a guideline for
naming interpretations so you can easily distinguish them from base rules.

1. Move the cursor to the top of the Rule table.  The ENG – Sanitary Landgill
(Area) interpretation is Sequence number 104.

2. In that row, select the Text… column and click the Zoom button.
 Note:  The description is from the National Soil Survey Handbook.
3. After reading the description, click Cancel to close the text editor.
4. Open the Rule Editor by highlighting the Rule column and clicking Zoom.  (See

the sample screen on the next page.)

The ENG
prefix

identifies this
rule as an

interpretation
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 Note:  You may need to adjust both your window size and display scale (refer to
graphic below) to view the rule editor.  The full rule is not visible on some
screens.  Scroll, if necessary, to view base rules.

 

 
 
5. When finished looking at the interpretation, click the Cancel button.
6. In the Rule Table, scroll down and look at the various records.  Notice that a

naming convention for interpretations includes a 3-letter prefix such as ENG,
AWM, FOR, etc.

 Note:  You can also use sequence numbers to differentiate between
interpretations and base rules, as shown on the next page in Table 16-1.  Notice
that sequence numbers reflect the disciplines that interpretations and base rules
fall under.

The operator
defines the
interactions

between the
limiting features

(base rules)

Scale is
adjusted to
75% and the
window resized
so all base
rules are visible
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Discipline Interpretation
Sequence
Numbers

Base Rule
Sequence
Numbers

Standard Engineering (ENG) 100-199 1000-1999
Waste Management Systems

(WMS)
200-299 2000-2999

Ag Waste Management (AWM) 300-399 3000-3999
Water Quality (WAQ) 400-499 4000-4999

Forestry (FOR) 500-599 5000-5999
Grazing Land (GRL) 600-699 6000-6999

Wildlife (WLF) 700-799 7000-7999
Agronomy (AGR) 800-899 8000-8999

Urban )URB) 900-999 9000-9999
Recreation (REC)

 
Table 16-1.  Sequence Numbers for Interpretations and Base Rules

 Note:  National interpretations included with NASIS 4.0 and shown here are not
yet official interpretations but provided now for the purposes of testing and
review.

7. When finished browsing through the interpretations in the Rule table, go on to
the next section where you can construct some sample criteria.

 

Constructing Interpretive Criteria
In the following exercise you will use the interpretive statement discussed in
Chapter 14:  A site has limitations for picnic areas if it is too steep or too wet.
Properties (such as slope and minimum depth to water table) are (1) retrieved from
the database, (2) evaluated according to the criteria's truth or membership function
(0.6 and 0.4), and (3) used in interpretations to make statements about the property's
effect on the specific interpretive application.

As previously mentioned, three of the four parts of the NASIS interpretive criteria
are interpretations, base rules and evaluations.  You will construct these using the
two graphical editors: Rule editor and Evaluation editor.  Recall that the fourth
aspect of interpretive criteria is the property.  Before you can evaluate an
interpretive statement you must define the relevant property.

We know that a property is the specified soil data (for example, the slope data
element) or soil characteristic (for example, depth to water table, which is not a data
element) retrieved from the soil database.  In the example of picnic areas, the
properties are slope and minimum depth to water table.  In this exercise, you will use
existing properties but create new evaluations, base rules, and an interpretation.

Creating new evaluations
For the picnic area scenario, you will create one evaluation from scratch and copy
and modify one existing evaluation.  For tutorial purposes, you can safely assume
that the two properties you want to evaluateSLOPE and DEPTH TO HIGH
WATER TABLE MINIMUMexist as already-written properties.
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1. Clear the selected set by selecting the File menu, then clicking New.  This helps
improve performance, if you and others are working through the lesson
simultaneously.

2. Click View, Evaluations, Evaluation to open the Evaluation table, which is
presently empty.

3. To create a new evaluation for the picnic area scenario, first insert a new row
into the Evaluation table by clicking F8.

4. For sequence number (Seq), type 5004, then press ENTER.
 Note: Sequence numbers in the Evaluation table can be used to group, maintain,

and develop evaluations.  Recall that sequence numbers reflect the disciplines
that interpretations and base rules fall under.  The same can be true for
evaluations.  See Table 16-1 on the previous page.

5. For Evaluation Name, type Slope evaluation for tutorial.
6. Highlight the Description field and click Zoom.
7. Type a description something like the one in the sample screen below.
 

 
 
8. After typing the description, click Apply.
9. Open the Evaluation Editor by highlighting Evaluation… and clicking Zoom.
10. To create the evaluation, first load the national properties by clicking the

National button.
11. In the Property Name choice list, scroll down and select SLOPE.
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 Note:  By default, the evaluation type for slope is linear.  As an expert, you have
the option of selecting the most relevant curve. For this example, however, use
linear curve.

12. In the Data field, type a Low Value of 5 and a High Value of 20, then press
ENTER.  The graph now reflects these values (resized and shown below).

 

 
 
13. If you think you want to write the interpretation as “If the soil is not too steep

then it does not have limitations for picnic areas,” you can use the Invert option
to change it.  Click the Invert button now.  It changes the perspective.

Load the National properties by
clicking the National button

From the Property name choice
list, select SLOPE

Low and
high curve

values
come from

the Data
field here
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 Note:  If you change the perspective of an evaluation already linked to a base
rule and an interpretation, you will likely need to change the wording of those as
well.

14. For the purposes of the picnic area example, undo the Invert by clicking it
again, then close the Editor by clicking Apply.

 Note:  Normally, you would save the evaluation to the database, but the save
function is disabled in the tutorial database.

 Note:  In the Evaluation table, next you will create a new evaluation for wetness,
but instead of building a new one, you will load an existing one, then copy and
modify it.

15. On the File menu, choose Select.
16. Select the query Tutorial - Evaluation by evaluation name and click Apply.
17. In the Query Parameters dialog, type Wet, Ground Water Near Surface

(120*, then click Apply.
18. A message informs you of one row added.  Click OK, then cancel the Select

Manager.  The Evaluation table now has another row.
 

  
19. With the cursor on the evaluation, click the Copy button.
20. When the cursor is active again, click the Paste button.
21. Highlight the Evaluation Name of the new record (row status N for new) and

click the Clear button on the NASIS toolbar.
 

Position cursor
in this row



Chapter 16:  DEVELOPING INTERPRETATION CRITERIA

(430-739, Version 5.0, Feb. 2001)     16.27

  
22. Type Wetness evaluation for tutorial and press ENTER.
23. To type a description, first highlight Text…, then click the Zoom button.
24. Resize the Text Field Editor to see more of the description.
25. Read the description of the evaluation you copied to determine what applies to

the new evaluation.
26. Delete the Ames description by highlighting it and clicking BACKSPACE (or

DELETE).
27. When finished editing the description (sample content below), click Apply.
 

 
 

 

28. Open the Evaluation Editor by highlighting Evaluation and clicking the Zoom
button.

29. In the Editor, change Evaluation Type to a Linear curve (the data values119.9
and 180.1—are automatically deleted).

30. Enter the data values:  low value is 0 and high value is 120, then press ENTER.
31. Looking at the curve, notice that the 0.000 minimum depth to high water table

means false or absolutely not true, but our interpretive statement states that
0.000 is true.  For this situation, invert the curve.

Click Apply

Highlight
the Evaluation

Name in the
New row then
click the Clear

button
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32. You have finished creating the wetness evaluation, so click Apply to close the
Evaluation Editor.

 Note:  You now have created two new evaluations, one for slope and one for
wetness.  However, evaluations can not be reported out unless they are linked to
a base rule.

Creating new base rules
Next, you will create two base rules to attach the evaluations to.  To report out the
result of an evaluation, you must create a rule and attach the evaluation to it.

1. Open the Rule table by selecting the View menu, Rules, then clicking Rule.
2. In the Rule table, insert a new row by pressing F8.
3. For sequence number, type 5998.
4. For Rule Name, type Slope base rule for tutorial.
5. Highlight the Text field and click Zoom.
6. Type the text in the sample screen below, then click Apply.
 

  
7. Highlight the Rule field and click Zoom.  The Rule Editor appears with one rule

componentStart Symbol.
8. Click the Add button and select Evaluation.
9. The Select Evaluation dialog appears. Use the arrow  to the right of the

Evaluation field to locate the Slope evaluation for tutorial.  Highlight it, then
click the Apply button.

 

  
 Note:  In the Rule Editor, an oval represents an evaluation.
10. Click the Edit button and select Rating Class.
11. Fill in the rating classes and values as shown in the following diagram.
 Note:  The TAB key moves between fields.
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 Note:  You may enter a maximum of fifty rating classes per rule.
12. Click Apply to close the Rating Classes dialog.
13. In the Rule Editor, click Apply to accept the rule and close the editor.
14. In the Rule table, insert another row by clicking F8.
15. For sequence number, type 5999.
16. Name this rule Wetness base rule for tutorial.
17. Highlight the Text field and click Zoom.
18. Type the following:  If soil is wet then wetness is a restrictive feature.  This

rule is a base rule of FOR - Picnic areas for tutorial; then click Apply.
19. Highlight the Rule field and click Zoom.
20. Click the Add button and select Evaluation.
21. From the Evaluation choice list, select Wetness evaluation for tutorial, then

click Apply.
22. Click the Edit button and select Rating Class.
23. Fill in the rating classes and values as shown here.
 

Enter the maximum rating value
associated with each range

Use meaningful
descriptions for
reporting rating

classes
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24. Close the Rating Classes dialog by clicking Apply.
25. Accept the rule as written and close the Rule Editor by clicking Apply.
 Note:  You have written two new base rules each with an evaluation linked to it.

Now you can create an interpretation and link the two base rules to it.

Creating a new interpretation with two base rules
In this portion of the lesson, you will create an interpretation, attach two base rules
to it, and then generate and preview the interpretation using the Interpretation
Manager.

1. Because interpretations are stored in the Rule table, press F8 to insert a new row.
2. For sequence number, type 599.
3. For the Rule Name, enter FOR - Picnic areas for tutorial.
4. Highlight the Text field and click Zoom.
5. In the Text Field Editor, type a statement such as that shown in the following

example, then click Apply.
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6. Open the Rule Editor by highlighting the Rule field and clicking Zoom.
 Note:  The Rule Editor opens with the Start Symbol displayed.  The Start

Symbol is a place holder; it performs no action.  The Rule Editor is where you
attach base rules to an interpretation.

7. The interpretive statement states that the interaction between steepness and
wetness is based on the OR condition.  Add the OR operator by clicking the Add
button and selecting Operator, the OR.

8. To add the first of the two evaluations, click the OR operator attached to the
Start Symbol, then click the Add button and select Rule.

9. In the Select Rule dialog, click the arrow to display the choices for rules found
in the tutorial database.  You see the two base rules you created.  Select Slope
base rule for tutorial, then click Apply.

 Note:  Slope evaluation for tutorial is linked to the interpretation as shown by
the rectangle symbol.

10. With the OR Symbol selected, click the Add button and select Rule.
11. This time, select the Wetness base rule for tutorial, then click Apply.  The

Rule Editor appears like the sample screen on the top of the next page.
 

  
 Note:  You have linked two base rules to an interpretation.  This action will take

the fuzzy analysis of wetness and of slope and return the most restrictive result
as the fuzzy logic rating for the overall interpretation.

12. To create rating classes for the interpretation, click the Edit button then select
Rating Class.
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 Note:  Again, the Rating Classes dialog is where you, as the expert, define the
rating classes associated with a range of values for a particular rule.  These
adjective descriptions are used to defuzzify rating values.

13. In the Rating Classes dialog, define four classes for this interpretation:  Not
limiting, Limiting, Very limiting, and Extremely limiting.

14. For each class, enter the maximum value of the range associated with the rating
class, as in the following sample screen.

 

  
 Note:  In this example, a value greater than 0 and less than .6 is not limiting;

greater than .6 and less than .9 is limiting, greater than .9 and less than 1 is very
limiting; and a value equal to 1 is extremely limiting.

15. Close the Rating Classes dialog by clicking Apply.
16. Position the cursor in the Primary Interpretation column, then click the Choice

button.
17. Highlight Yes, then close the Choice dialog by clicking Apply.
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Note:  Top level interpretations are designated as primary. In the tutorial, the
FOR – Picnic areas for tutorial interpretation is not called by any other
interpretation.  Decisions about suitability of the location as a picnic area is
based on the rating provide by this interpretation.  Had this interpretation been a
subitem to (called by) another interpretation, the Primary Interpretation filed
would have kept the default setting of No.

 Note:  You have finished creating the interpretation with two base rules.  In the
next section you will build a selected set, generate the interpretation, and then
preview the report.

Generating an Interpretation with Two Base Rules
In this lesson, you can use the same selected set you built for Chapters 13 and 14.
Like all reports in NASIS, data in the selected set is the basis of this report.

In Chapter 13, you ran the Tutorial - Soil survey area, all data query to retrieve data
for Canyon County, a published soil survey correlated in September 1985.  Refer to
pages 13.2-4 if you need more information about reloading the data, then proceed to
step 1 below.

1. On the Options menu, select Standard Reports.
2. In the Report Manager, select the National site and choose INTERP – Portrait

Table report.
 

 
 
3. The report parameters dialog is displayed.
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4. When you are ready to run the interpretation, click FOR - Picnic areas for

tutorial.
5. In addition to the default selections, select the following:  Print RV, Reporting

Depth of 2, and Maximum Non-Zero Reasons of 2. The Report Name is
optional.  Type FOR - Picnic areas for tutorial.  Click Apply, NASIS begins
generating the interpretation.

 

 
 
 Note:  If you did not load all the tables required to run this report, a message

will indicate it.
6. When the Report Viewer appears, use the page down arrow or the scroll bars to

look through the report (resized and shown below).
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7. After reviewing the interpretation result listing, click the Cancel button.
8. Click Cancel again to exit the Report Manager.
 Note:  You have finished Chapter 16.  Go on to Chapter 17 for a lesson on

writing custom queries.
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